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Overview 
Abra2BST allows Abra users to interface their Abra human resources and payroll data with BST 
Enterprise from BST Global. With its easy-to-use interface and customization, you will be able to pass 
your employee data, from Abra, to BST. The same interface allows you to pass your BST time data to 
Abra payroll. 

Installation 
Abra2BST can be installed on either your local hard disk (typical installation), as a stand-alone system, or 
on a network drive (workstation installation). This software can be installed on as many PCs as needed 
without any licensing restrictions. Upon completion of the installation, store the original Abra2BST 
installation CD in a safe place. In the event program files are damaged or deleted, or if re-installation is 
required, the original CD is needed to re-install Abra2BST. 
 

 LICENSING ABRA2BST: Please install Abra2BST first before applying the license. To apply the 
license, please follow the steps outlined in Appendix A – Licensing Abra2BST on page 32. 

 

This quick-reference guide assumes some proficiency in using Windows and 
installing software. 

Stand-alone Installation 
To install Abra2BST, insert the installation CD on the desired computer. Double click on the Abra2BST 
Application Installation.exe icon and follow the installation prompts. A shortcut will appear under the 
Start button: 
 
 Start  All Programs  Abra2BST 

Network Installation 
1. Install the Abra2BST application on the server, where Abra is installed. Double click on the 

Abra2BST Application Installation.exe icon and follow the installation prompts. 
2. Once installation on the server has completed, follow the setup procedures (see Abra2BST Setup 

on page 5). 
3. On each of the client PCs, install the Workstation Installation, by double clicking on the 

VFP_SP2_Workstation_Installation.exe icon and follow the installation prompts. 
4. Create a shortcut on each client PC to the Abra2BST.exe application on the server. You should 

have a drive letter mapped to the server (in many cases, the same drive letter as Abra). Be sure 
to enter the application path in the Start In field (see Appendix C – Frequently Asked Questions 
(FAQ) on page 35). 

 
 

Installation of Abra2BST will result in a 14-day trial of the software. To avoid uninterrupted 
use of Abra2BST, please contact CAASPRE Consulting at www.caaspreconsulting.com to 
obtain a license.  

http://www.caaspreconsulting.com/
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Abra2BST Setup 
Before you can begin using Abra2BST, the first thing Abra2BST will do is alert you that it needs the 
location of the Abra data path. Whether on the network server or stand-alone PC, follow these four, 
must-do steps (see the Options window): 
 

1. Locate the Abra data directory by clicking on the browse button. Abra2BST will validate the 
directory to determine if it is a valid Abra data directory. 
 
Note: For Sage Abra version 9.x, see Appendix F – Working with Abra version 9 on page 41. 
 

2. Locate the export directory. BST will export its time export files in the Abra Data, Export 
directory. It is highly recommended that you use this directory. 

3. Set the Include Terminated Employees? Option. You can export terminated employees for up to 
one year. The default is 0 Days. 

4. Determine what the Import Frequency is, Weekly or by PayCycle. The Import Frequency 
determines how often you want to import pay data into Abra. Abra2BST will adjust the BST 
export file accordingly. The default is PayCycle. 
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Abra2BST Options 
The Options window contains additional configuration choices. You can open the Options window by 
selecting Tools  Options from the menu.  

 
 

Adjust for Different Company Codes 
If the company codes in Abra and BST are the same, there is no need to check this option. If they are 
different, select it. A Map Co Codes button will appear. This will ensure that Abra gets the correct 
company code when importing pay information and BST gets the correct company code during its 
employee import. 
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Click the Map Co Codes button to map the Abra company code with the BST company code.  
 

 
 
To enter the BST company code, click on the company code and enter the code in the field provided. 
Clicking the Close button will automatically save your changes. 
 
Click the Reset button to restore the company codes back to its default values (the Abra company code). 

Use OT as the Overtime Code 
By default, Abra2BST will use “OT” as the overtime code. Should you require a different overtime code, 
uncheck the Use OT as the Overtime Code checkbox. The Map OT Codes button will appear. 
 

 
 
Click the Map OT Codes button and the Map Overtime Codes window appears. To change the overtime 
code, select the desired company code and enter the code in the field. 
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Please be aware that manually entering a code does not validate the code against the Abra earnings 
code. This code will be used throughout the entire company during the timesheet import. 
 

 
 
To enter a valid Abra overtime code, select the company code and press the F2 key. A list of earnings 
codes will appear. Select the desired overtime code and click Save. Also note that this list contains the 
eight miscellaneous fields, p_jmisc1 through p_jmisc4 and p_misc1 through p_misc4 and the p_mailstop 
field (see note below). 
 

 

Note: By selecting an Abra earning code, the overtime code will be used for the 
entire company. If any of the miscellaneous or the mailstop fields are selected, 
Abra2BST will use the contents of that field by employee. This is used if employee-
specific overtime codes are required. 
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Is Abra Numeric Employee ID Turned On? 
When this option is selected, Abra2BST will adjust the employee number to the format used in Abra as a 
numeric employee ID. Please make sure this option matches Abra. If Is Abra Employee ID Numeric is off, 
do not check this option. 

Use BST’s Actual Time for Salaried Employees 
When this option is selected, Abra2BST will use the actual time entered into BST for salaried employees. 
When this option is not selected, Abra2BST will use the values in the Normal Hours/Units field in Abra 
for salaried employees. 

Include Adjustments 
This option is available when the Use BST’s Actual Time for Salaried Employees option is selected. 
Include Adjustments inserts an additional row in the Abra timesheet file for salaried employees whose 
BST hours do not match the normal hours entered in Abra.  This row is inserted as a positive or negative 
and adjusts the time to be paid to the normal hours.  
 
This option resets itself to unchecked when de-selecting the Use BST’s Actual Time for Salaried 
Employees. 
 
If you are using a post code for adjustments, click the Map Adj Codes button to pick the desired code. 
 

 
 
To enter a valid Abra adjustment code, select the company code and press the F2 key. A list of earnings 
codes will appear. Select the desired overtime code and click Save. 

Include Non Employees from Abra 
When this option is selected, Abra2BST will export non-active employees (where pe.p_active = ‘N’). 

Delete Abra PrPost Files Before Importing 
Under normal circumstances, Abra2BST will allow you to import pay records into Abra as many times as 
necessary. With this option enabled, each import will delete its previous entry (note once payroll is 
complete, the PrPost table is emptied and archived). Without this option, any previously imported pay 
records will remain in Abra. 
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This option does not delete any entries made in PRPOST by other methods. 
Abra2BST inserts the import file name into the project field and uses it as its point 
of reference. 

You may want to turn this option off when setting the Import Frequency to weekly while running a bi-
weekly, semi-monthly or monthly payroll. Otherwise, it will delete your previously imported timesheets. 
 
You can also delete all Abra2BST pay entries manually by selecting Tools  Delete All Abra Payroll 
Entries. 

Include Temp Rate, if available? 
If the temporary rate is exported with the BST file and this option is selected, the temporary rate will 
supersede the employee’s primary pay rate. If this option is not selected, the import process will ignore 
the temporary rate.  
 
This option is on by default. 

Use Multi-Record Custom Pages? 
When creating Abra Custom Pages, you have the option of creating multi-record custom pages. This 
gives the Abra users 999 multi-pages they can create and store data in. Custom Pages can be used to 
add customized data to Abra. Abra2BST already uses the TKPE table, by default, in the employee export. 
By selecting this option, any multi-record table, if found, will be loaded. Once set in the Export File 
Layout (page 16), this data can be exported from Abra during the employee export. 
 
This option is off by default. 

Include Terminated Employees? 
To include terminated employees in the employee export, select the amount in the field provided and 
select the interval from the drop-down list. The maximum value that Abra2BST will use is one year (or 
365 days). Changing the terminated amount to 0 excludes terminated employees from the export. 
 

 
You have the option to use the Pay Status or Employee Status.  

• Using Pay Status, Abra2BST will query p_paystat field.  
• Using Employee Status, Abra2BST will query the p_active field. 

Import Frequency 
 
You can use Abra2BST to import timesheets into Abra on a weekly, biweekly, semi-monthly or monthly 
basis.  
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Note: If the Use BST’s Actual Time for Salaried Employees option is not selected, and the import 
frequency is weekly, Abra2BST will automatically adjust the salaried employee’s hours, based on Abra’s 
setting, to a weekly amount. 
 
If you import on bi-weekly, semi-monthly or monthly basis, set the Import Frequency to “PayCycle.” 

Advanced Options 
To access the Advanced Options, click the Advanced Options… button at the bottom of the Options 
window.  
 

 
 

Open Abra2BST Command Center Upon Launch? 
If you want the Abra2BST Command Center to load upon opening the software, check this option. If you 
do not want the Command Center to open, uncheck this option. This feature is on by default. 

Ignore the Tax Code during the Import? 
Beginning with BST Enterprise version 8.4.0.6, a new tax work code is available for the payroll import 
into Abra. Abra2BST also supports this tax code.  
 
There are a few things to consider when using this tax code option. BST Enterprise uses three characters 
for the code, Abra uses four characters. The tax codes must match each system before it will work 
correctly.  

Having the wrong code will affect the employee’s taxes. Please make sure your 
tax codes are working correctly by testing before running final payroll. 

To ignore the importing of the tax codes from BST, check Ignore the Tax Code during the Import (payroll) 
option in the Advanced Options setting. To import the BST tax codes, uncheck this option. 
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General Ledger Options (Optional) 
If you purchased the General Ledger module (optional), the General Ledger Options button will appear 
at the bottom of the Options window. 

 
To set the General Ledger Options, click the GL Options… button. The General Ledger Options screen 
will appear. This screen allows you to set your General Ledger Export defaults. 

 

Org Level 
The Org Level is the organizational level in Sage Abra that has been designated to track General Ledger 
information. The Organization Tab of the Current Job panel should be labeled to help identify this. 
Organization levels are numbered from one (the top level) to five (bottom level). 
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Summarize by Org Level? 
The Abra2BST General Ledger can contain quite a bit of data. If the regular export contains more data 
than you would like to import, the Summarize by Org level option will summarize the data by the five 
Abra Organization Levels, meaning once any of the organization-level data changes, Abra2BST will create 
a new summary line. 

Doc Type 
The Doc Type is the document Type used in BST Enterprise for the document type suffix. The default is 
**. This option only accepts two characters. 

Use the Organization Level to Update the Company Code? 
When this option is selected, Abra2BST will use the selected Organization Code to use as the company 
code in the General Ledger export. 
 
Normally, Abra2BST will use the company code based on the normal Abra company codes or the cross-
referenced code (see Adjust for Different Company Codes on page 6). However, if the company codes 
used in BST for the General Ledger are in any of the five organization levels, select this option and select 
which organization level it is in. 
 
If the company codes in the organization levels do not match BST’s, there is a cross reference table that 
can be created. Simply check Cross Reference Company codes? under this option. 

Post to Project 
If you are exporting general ledger expense accounts to BST and your expense account in BST is set up to 
post to projects, you will need to check this option and update the settings. 
 
When this option is checked, you will also need to set the Project, Phase and Task Code. These will be 
used in the export, by default (until they are changed). Unchecking this option does not remove 
previously saved data from the Project, Phase and Task Code. 
 
If you are not exporting any accounts to BST that post to projects, you must uncheck Post to Projects. 

Post GL Export Directly to BST? 
Beginning with Abra2BST version 2.1, you have the option to post the General Ledger export directly 
into BST without using any third-party or SQL Server import tools. 
 
If you prefer to create the CSV export, uncheck this option. If you would like a direct import into the BST 
General Ledger Import Table, check this option. 
 
In order to post the General Ledger directly into BST, you will need to set up the SQL Server credentials 
(see BST SQL Server Authentication on page 14). 
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BST Utilities 
Abra2BST now has the option to perform basic clean-up functions in BST. Before Abra2BST can 
connection to BST’s database, it needs credentials to do so. 

BST SQL Server Authentication 
The BST SQL Server Authentication window can be access from BST Utilities   BST Options. 

 
The user running Abra2BST must have access to the BST database by using either Windows 
Authentication or SQL Server Authentication (please see your IT Department to set this up). 
 
To set up a connection to the BST database, enter the BST Server Name and the Database Name in the 
fields provided. 
 
If you are using Windows Authentication, check the Windows Authentication checkbox.  
 
If you are using SQL Server Authentication, uncheck the Windows Authentication checkbox and enter 
the user name and password. 
 
To test the connection, click Test Connection. If the 
connection was successful, you will see this message. If not, 
please check your entries to make sure they are correct. 
 

The password is case sensitive. Also note that the 
database collation can be case sensitive 
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Clear BST Interface Import Tables 
Abra2BST uses, directly or indirectly, two import tables that are in BST. BST does not delete any rows in 
the employee import table when importing employees. Sometimes import errors occur when importing 
employees. These errors can be alleviated by clearing out the import table. The BST employee import 
process will populate this table again during the next import. 
 
To access the Clear BST Interface Import Tables, select from BST Utilities   Clear BST Interface Import 
Tables. 
 
BEFORE THESE FUNCTIONS WILL WORK, A CONNECTION TO THE BST DATABASE MUST BE ESTABLISHED. PLEASE REVIEW THE 
BST SQL SERVER AUTHENTICATION SECTION ON PAGE 14. 
 
To remove all the rows from the employee import table, select Delete the BST Employee Import 
Records and click Delete. 
 
To remove all the rows from the general ledger import table, select Delete the BST General Ledger 
Import Records and click Delete. 

 
USE WITH CAUTION. THESE FUNCTIONS WILL PERMANENTLY REMOVE THE DATA FROM THESE TABLES AND SHOULD 
ONLY BE USED DURING A SUPPORT CALL. 
 

 
  



Abra2BST Reference Manual 
 

Revised 11/06/2012 
 

16 
Tools Menu 
Commands from the Tools menu allow additional configuration and functionality to Abra2BST. 

Export File Layout 
The Export File Layout comes pre-configured with BST’s default employee import. These entries are user 
editable and should be able to accommodate any changes BST makes in the future. 
 

   

Warning: Making any changes to this configuration could cause your export file 
to become inoperative. You should be proficient with Visual Fox Pro and the Abra 
data structure.  Use with caution. 

Expression Tips  
• Pulls data from the hrpersnl (pe) and hrtkpers (tkpe) tables (personnel and custom panel tables 

respectively). 
• If the Multi-Record Custom Pages option is selected, Abra2BST will look for, and load, all tables 

starting with TMUL001 through TMUL999. These tables will be available to build an expression. 

• To verify an expression in the Expression field, click the  button. Note: this button will not 
appear if the Multi-Record Custom Pages option is selected. Use the Expression Builder Verify to 
verify your expression. 

• Use the  button to load the Expression Builder (see page 18). 
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• The VFP 9.0 language reference can be found on Microsoft’s MSDN website at 

http://msdn.microsoft.com/en-us/library/74zkxe2k(VS.80).aspx  
• When creating an IIF statement where a single character or number is used in the condition, 

Visual FoxPro will use the length of the first result for the entire column.  
 
For example, if you create a condition to return values such as 75000.25 or a 0, based on a 
condition, and the first value returned is a 0, all subsequent rows will be one character in size.  
 
Change iif(x = y, pe.p_annual, 0) to iif(x = y, pe.p_annual, 000000000.00)   

For more information on expressions and building expressions, please see 
Appendix E – Expression Builder Dialog Box on page 39) 

Reorder All 
If for some reason the ordering of the columns gets out of order, click this button to fix the ordering of 
the expressions. 
  

http://msdn.microsoft.com/en-us/library/74zkxe2k(VS.80).aspx
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Expression Builder 
You can use the VFP Expression Builder to build, and verify, your expression. To use the Expression 

Builder, click the  button next to Expression field. The Expression Builder Window will appear. You 
can select the table under the From table dropdown list and select the required fields under the Fields 
list.  

  
 To verify the expression, click the Verify button. If all is well, you will see the result in the status bar in 
the lower left corner of the screen. If not, you will see a dialog. 

   
 
For more information on the Expression Builder, see Appendix E – Expression Builder Dialog Box on page 
39).  
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Employee Number Conversion 
There are times when the Abra and the BST employee numbers do not match exactly. If this is the case, 
the employee numbers can be altered so the BST employee import and the Abra timesheet import will 
work. You can adjust the composition of the employee number by entering an expression in the 
Employee Number Conversion window. 
 
To open the Abra2BST Employee Number Conversion window, select Tools  Employee Number 
Conversion.  You can adjust how BST accepts the employee number, most commonly, by padding it. 
 

 

Visual FoxPro Commands for Padding Employee Numbers 
 
Pad Left PADL(eExpression, nResultSize [, cPadCharacter]) 
Pad Right PADR(eExpression, nResultSize [, cPadCharacter]) 
Pad Both Sides PADC(eExpression, nResultSize [, cPadCharacter]) 
 
eExpression 

Specifies the expression to be padded. This expression can be any expression type except a 
logical expression or a general or picture field. 

 
nResultSize 

Specifies the total number of characters in the expression after it is padded. 
 
cPadCharacter 

Specifies the value to use for padding. This value is repeated as necessary to pad the expression 
to the specified number of characters. If you omit cPadCharacter, spaces (ASCII character 32) are 
used for padding. 
 

 Example 
Padl(alltrim(pe.p_empno),6,'0')  '000123' (The alltrim command is used to trim all spaces of 
the field) 
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Reindex 
The Reindex the Database option allows the re-indexing of the Abra2BST tables and indices.  
 

 
 
The Compress Files option will remove any records marked for deletion. 
 
The Compress Error Log button will delete any entries into the error log older than 30 days. 
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View Error Log 
You can view the error log by selecting View Error Log from the Tools menu. The error log is useful for 
displaying any errors in the system that shuts down Abra2BST. Every error is logged. 
 

 

Printing the error log 
To print the error log, click the specified error in the grid. The Error Details panel will update. Click the 
Print Preview button. The Error Log report will appear as a preview. To print the error log, click the Print 
icon in the report toolbar. 

Deleting Errors 
To delete all errors in the error log, click the Delete Errors button and confirm that you want all errors 
deleted. 
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Abra2BST Command Center 
The Abra2BST Command Center will appear each time Abra2BST loads. Should you close this window, 
you can always open it by selecting File  Abra2BST Command Center from the menu. Similarly, you 
can press the ALT-C keys. 
 
Most of the application’s options will appear in the Options Selected section. This area is for display 
purposes only and used as a quick reference of the options selected.  
 

 

Exporting Abra Employees for BST 
To export Abra employees for BST to import: 

1. Select Abra Employee Export from the Select an Activity section. 
2. Select the company (or companies) to export by moving them over to the Selected Company 

Codes section. 
3. Click the Process Files button. A Successful Confirmation dialog box will appear with the location 

of export file. 
4. While in BST, import the employees (see the BST Enterprise user guide for instructions). 

 
The exported file will be created in the export folder that you specified in the options. It will contain the 
following file name: 
 
 AUREMP03.CSV, where EMP stands for employee. 
 
Options Selection 
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The Options Selection allows the user to decide whether to delete Abra payroll entries and/or change 
the import frequency before importing. Changes made here are reflected in Abra2BST’s options. 

Importing Abra Pay Records from BST 
To import pay records from BST for processing payroll in Abra: 

1. Export the pay records from BST (see the BST Enterprise user guide for instructions). 
2. In Abra2BST, select BST Time Import option from the Select an Activity section.  

 

 
 

3. Select the company (or companies) to export by moving them over to the Selected Company 
Codes section. The bottom of the screen will change to display the files to import. 

4. Abra2BST will automatically find the pay record files, provided the files are in the directory, and 
display them in the Files To Process section. If the files are not found, you have the opportunity 
to manually locate them, if they exist. Note, both files may not be generated in BST. This is OK. 

5. To review an import file, select the file from the list and click the Preview File button. This step is 
optional and not required for importing. This report can be printed, if needed. 

6. If everything checks out, click the Process Files button. 
 
Note:  If the BST export file contains temporary rates, the temporary rates will be used instead 
of the permanent rates. 

 
7. Review your time entries in the Abra Payroll. Process the payroll as usual. 

Note: The BST Global time export file, starting with Version 8.4.0.6, will now 
include the tax work code. Abra2BST will pick up the work code, if it exists, and 
import it into the Abra Payroll timesheet file. 

Abra2BST Optional Modules 
There are two optional Abra2BST modules, which can be purchased from your Abra2BST Authorized 
Reseller. The General Ledger (for general ledger distributions into BST) and Custom Solutions can be 
purchased together or separately. 

General Ledger Module 
The General Ledger Export module will export the entire payroll entry, liabilities and expenses from Sage 
Abra for import into BST Enterprise. If you have purchased this module, the option General Ledger 
Export on the Abra2BST Command Center window is enabled. 
 
To export the journal entries: 

1. Select General Ledger Export from the Select an Activity section. 
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2. Select the companies to export. You can process only one company at a time. 
3. Click Process Files. 

 
When clicking the Process Files… button, a window will appear with the General Ledger export options. 
 

 
• When processing the General Ledger Export, enter the Check Date and Period End Date as they 

were entered during the Trial Payroll 
 
The Organization Level (Org Level) and the Document Type fields are present to modify for the export, if 
necessary.  If you are exporting General Ledger expense accounts to BST and your expense account in 
BST is set up to Post to Project, you will need to check this option. If you are not exporting accounts to 
BST that post to projects, uncheck this option (please see General Ledger Options (Optional) on page 
12). 
 
Please note that making changes to the Org Level, Document Type and Post to Project will save to 
your preferences and will be available the next time you export your journal entries. 
 
To export the journal entries, click the Run button. When the export is complete, a pop-up window will 
tell you the name of the file export. The file naming convention is AURGL[COCODE]03.CSV and will be 
located in the export directory specified in the Options. There is an auto-increment feature with the GL 
files. After the file is processed, Abra2BST will ask you if you want to increment or overwrite the file. 
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Custom Solutions Module 
The Custom Solutions module is written by CAASPRE Consulting and allows users to run custom solutions 
written specifically for your company and Abra environment.  
 
If after importing the BST pay data and you still find yourself manipulating earnings codes, units, pay 
rates, updating secondary job codes or anything else, manually, a custom solution can save your 
company many hours and money over time. Custom Solutions are a powerful way to allow users to 
modify Abra data that was otherwise performed manually. 
 
Solutions can be written as an application (APP), a compiled program (FXP), a regular, un-compiled 
program (PRG), a SQL statement (SQL) or as a regular executable (EXE). All custom solutions are 
maintained in the \custsol folder under the Abra2BST folder. 
 
To run a Custom Solution, the option must be made available on the Abra2BST Command Center. It 
appears in the Activity section.  

 If this option is grayed out (and not accessible), you do not have the Custom 
Solution module installed. 

Select the Custom Solution activity and select the companies that require this function. To begin, click 
the Process… button. The Abra2BST Custom Solutions Panel will appear. In this window, you can run a 
number of custom solutions of various types (see below). 
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Select solution in the Custom Solutions Panel and click the Run button. Abra2BST will ask you if you are 
sure you want to run the custom solution. Click OK to proceed or cancel to abort. Depending on the 
amount of data that requires updating, you will see a progress bar appear.  
 
Once the solution is done, you will see a message stating the custom solution has completed.  
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Reports 
There are a couple of reporting options in Abra2BST, the BST Export Preview Report and the Abra 

BST Export File Preview Report 
Use the BST Export Preview Report to review the contents of the BST export files.  
 

 
 
To preview the BST Export File Preview Report, make sure Abra2BST is in import mode. Select the file in 
the Files to Process section. Then click the Preview File button. 
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Abra Timesheet Report 
 
There is a report available that details what was imported into Abra Timesheets.  To use this report 
select Reports  Abra Report from the Menu Bar at the top of the screen.   A dialog box will appear. 
 

 
 
Under the Report Options section select the Abra Timesheet Report under the Report Type. In the future, 
additional Abra reports will be added here.  
 
You can choose the sort order by selecting Employee Number or Employee Name in the Order By drop-
down list. 
 
Under Print Options  Print To: you can select to Preview or Printer to view or print the report. 
 
After making your choices click on the Print button to view or print the report.  Either option will take 
you to the Print Preview window.  Click on the Printer Icon to send the report to the default printer. 
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Error Log Report 
The Error Log report displays any error received in Abra2BST. It is useful for diagnosing any issues you 
may encounter. It is printed from the View Error Log window. 
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Abra2BST Registration Info 
You can view your Abra and Abra2BST registration information selecting Window |Register Abra2BST. 
This will display the Abra Company, serial number and the installation code. 
 
 Once the Abra2BST license has been applied, REGISTERED will appear in the Abra2BST Activation Status 
will appear. 
 

 
 
The red text will display whether your Abra2BST maintenance is up to date or if your maintenance is 
expiring within 45 days.  
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Appendix A – Licensing Abra2BST 
 
 
Licensing Abra2BST is a simple procedure that requires just a few steps. You can apply the license during 
the 14-day trial or even after the trial period is over. 
 
To license Abra2BST, you will receive a license file from CAASPRE Consulting that works with your 
installation of Abra. The license is tied to your Abra serial number. This information is required before a 
license is issued. 
 
The file, license.app, contains the information necessary to perform this step.  
 
Follow these steps to license Abra2BST: 

1. Make sure all users are out of the system. 
2. Copy the license.app file directly into the folder where Abra2BST.exe is located. 

a. If on a network server, copy this file to the version on the server. 
b. If on a stand-alone computer, copy to c:\program files\caaspre consulting\abra2bst. If 

installed on a 64-bit computer, the file location will be at c:\program files (x86)\caaspre 
consulting\abra2bst. 

3. Run Abra2BST. 
4. If successful, you will receive a message that the license was applied. 

 
 

SOME ABRA2BST FILES CAN BE DELETED AND BROUGHT BACK TO ITS DEFAULTS DURING THE 
NEXT EXECUTION. HOWEVER, USE EXTREME CAUTION WHEN DELETING ANY FILES AS YOU CAN 
MAKE YOUR ABRA2BST INSTALLATION INOPERABLE. CONSULT YOUR ABRA RESELLER OR 
CAASPRE CONSULTING.   

  



Abra2BST Reference Manual 
 

Revised 11/06/2012 
 

33 
Appendix B – Updating Abra2BST 
 
You can receive Abra2BST updates via the CAASPRE Consulting website (www.caaspre.com) or through 
the Abra2BST Updates menu. Updates are available periodically and you can download anytime as long 
as your maintenance is up to date. Your annual maintenance allows for unlimited technical support and 
ensures that Abra2BST will work whenever Sage or BST Global updates their respective products. 

Update via Abra2BST Update Menu 
To receive the latest update, select Abra2BST Update from the File menu. The Abra2BST Update window 

will appear. Next, click the Verify 
Eligibility button. If your 
maintenance is up to date, you will 
see the username and password 
required to download update. 
 
Click the Download button to open 
the link to the latest update.  
 

 
 
Enter the required username and 
password when the download 
window appears. 
 

Once the update is downloaded, unzip the contents of the download and overwrite the Abra2BST.exe 
file in the program folder. 

Steps to update Abra2BST 
As updates to Abra2BST occur, perform the following steps to update the Abra2BST application: 

1. In a multi-user environment, make sure all users have closed Abra2BST. They must remain out of 
the system while the update is being installed. 

2. Locate the folder where Abra2BST.exe exists. 

3. Copy the new Abra2BST.exe into this folder and replace the existing file. You will be prompted 
to overwrite the existing file. Click Yes if using Windows XP or Copy and Replace in Windows 
Vista or Windows 7. 

4. Start Abra2BST. There may be times where the update will modify the data tables. No other 
users can be in the system while this happens. 

5. The update is complete. At this time, all users can begin using the system. 
  
  

http://www.caaspre.com/
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IF YOU REQUIRE TECHNICAL ASSISTANCE, PLEASE CONTACT CAASPRE SUPPORT AT 813-333-1661. 
 
TO VERIFY THE VERSION THAT IS INSTALLED, GO TO THE WINDOWS DROP DOWN MENU AND SELECT ABOUT 
ABRA2BST… THE VERSION SCREEN WILL APPEAR SHOWING THE INSTALLED VERSION. 
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Appendix C – Frequently Asked Questions (FAQ) 
 
Q When I run Abra2BST on a network for the first time, I see a2b files created on my desktop. 

Why? 
A. The Start In field in the shortcut properties is empty. 

 
To resolve this, make sure the Start In field contains the 
same path as the application. Type, or copy and paste, 
the full path. 
 

Note: Be sure not to include the application 
name in this field. Only use the path. 

  
Q. In a multi-user environment, do all Abra2BST workstations require the same drive letter? 
A. Yes. Currently, Abra2BST does not allow multiple drive-letter mappings to the Abra data. 
  
Q. My old IDEAL BST Link application used to create separate employee export files for each of 

my companies. Where are they? 
A. Abra2BST creates one file for all the companies selected in the pick list. The company code is 

included in the file named AUREMP03.CSV. 
  
Q. I see double timesheet entries in my Abra timesheet. Why? 
A. The timesheet import process was selected twice and the Delete Abra Prpost Files Before 

Importing option is not selected. All files listed in the Files to Process list are imported at the 
same time. 

  
Q. I import timesheets on a weekly basis, but process payroll bi-weekly. I have imported the 

second week of timesheets into Abra and I only see one. Why? 
A. The Delete Abra Prpost Files Before Importing option is selected. This option will remove any 

previously imported timesheet entries during the next timesheet import. 
  
Q. Do I need to use the custom panel for my company codes if I have a multi-company setup? 
A. No. If your company codes in Abra differ from BST, select the Adjust for Different Company 

Codes option on the Options screen, click the Map Co Codes button and map the BST company 
codes in the space provided. 
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Q. Do I need to use the custom panel if I have employee-specific overtime codes? 
A. Not necessarily. Abra does not currently store employee-specific overtime codes as it does for 

normal, sick and vacation hours. You can use one of the eight Abra miscellaneous fields and 
the infrequently used mail stop field when setting up employee-specific overtime codes. 
Abra2BST does not currently pull pay data information from the custom panel. 
 

Q. My overtime code descriptions are not displayed in the Time Entry screen? 
A. Be sure that your overtime codes are set up correctly (see Use OT as the Overtime Code on 

page 7). 
  
Q. I selected one of the two BST files to import into Abra’s timesheets, but both files imported. 

Why? 
A. The import (into Abra) process imports all files that BST exported, based on company. If, for 

any reason, you want to import only one of the two export files, check the Manually locate the 
import file? checkbox and browse to the desired file. 

 
Q. I have imported my BST timesheets into Abra. Why do I see an extra time-entry line in the 

timesheet? 
A. The extra line is not part of the BST timesheet import and is not stored in the database. This 

line is by design, from Abra, to aid in data entry of the timesheet. This is called the “working 
line” and there is no need for concern. 
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Q. Can I use Microsoft Excel or any other spreadsheet application to open any of the BST export 

files? 
A. It is highly recommended that you do not use Excel to open the export file. Excel will truncate 

any leading zeros to employee numbers, for example, and will cause the Abra2BST import to 
work incorrectly. Use Notepad or WordPad instead if you need to look at the BST export data. 
From Abra2BST, you can use the Preview File described on page 27 of this manual. 

Q. When I run Abra2BST, I get the error, File Access is denied. Why? 
A. There is a feature called User Access Control (UAC) that was introduced in Windows Vista that 

prevents arbitrarily writing to the Program Folder.  
 

 
 
To fix, set your shortcut to Run as Administrator. 
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Appendix D – Converting IDEAL’s BST Link Application 
 
Abra2BST is the next level of linking your Abra and BST data. Since Abra and BST are both customizable 
and configurable, you have already spent time configuring these applications. As such, Abra2BST must 
also be configured to match the uniqueness of the Abra and BST systems. If you are using IDEAL’s BST 
Link application, converting this configured data to run with Abra2BST is a mouse click away. 
 
To begin the conversion, follow these easy steps. 

1. Select IDEAL Link Conversion from the File menu. A dialog will appear confirming your desire to 
convert the IDEAL data. By performing this action, you will overwrite your current Abra2BST 
human resource export settings. To continue click Yes. 
 

 
 

2. The IDEAL Link to Abra2BST Conversion window will appear. 
 

 
 

3. Click the Browse button (…) to locate the IDEAL BST Link files. These files are usually located in 
the Abra Programs Folder. 

4. Once located, click the Convert button. 
5. A dialog will appear confirming that you want to perform the conversion. Click Yes to continue. 
6. The conversion will take moments. After the process has completed, Abra2BST will respond with 

a dialog. Abra2BST will also alert you if there are any errors in the conversion. 
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PERFORMING THE CONVERSION DOES NOT WRITE ANY DATA BACK TO IDEAL’S BST LINK APPLICATION. 

Appendix E – Expression Builder Dialog Box 
 
The following excerpt was taken from the Microsoft Visual FoxPro manual. Additional help can be 
obtained at http://msdn.microsoft.com/en-us/library/78f792f3(VS.80).aspx.  
 
Copyright © Microsoft Corporation. All rights reserved. 

 
The Expression Builder makes it possible for you to create and edit expressions. The Expression Builder 
provides lists of appropriate options and can be opened from various designers, windows, builders, and 
wizards. 
 
To create an expression, type it into the Expression box or select items from the Functions lists. An 
expression can be simple, such as a field name, or complex, such as a calculation involving IIF( ) 
functions, concatenations, and data type conversions.  
 
Expression  
Displays the expression that you are creating or editing. 

 
Tip  
You can enter more than 255 characters as well as extended characters, such as CHR(13) (carriage 
return) and CHR(10) (linefeed), for expressions in the Expression Builder. The Expression box in the 
Expression Builder supports color syntax and background compilation when turned on.  
 
Caution  
Property values that exceed 255 characters or include extended characters contain padding with CHR(1) 
characters. However, classes in visual class library (.vcx) files that contain properties with such values 
cannot be used in versions prior to Visual FoxPro 9.0. If you attempt to modify these classes in a prior 
version, an error occurs. You can still use other classes in the same visual class library (.vcx) files with 
previous versions of Visual FoxPro as long as they do not contain property values exceeding 255 
characters or include extended characters. 

 
Functions  
Displays lists of function types. When you select a function from one of the four types, Visual FoxPro 
automatically pastes it into the expression box. When you are building expressions for remote views, 
Visual FoxPro lists only the functions specific to the target back-end data. 
 

• String   Lists available character string functions. 
• Logical   Lists available logical functions. 
• Math   Lists available math functions. 
• Date   Lists available date and time functions. 

 
Fields  
Lists the fields in the current table or view. 
To paste a field into the Expression box, double-click the field or select the field and press ENTER.  
To display fields from a different table, select a different table in the From Table box.   

http://msdn.microsoft.com/en-us/library/78f792f3(VS.80).aspx
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From Table  
Lists tables and views that are open. Select a table or view to update the Fields box. 
 
Variables  
Lists system memory variables, arrays, and memory variables that you have created. 
To paste a variable into the Expression box, either double-click the variable, or select the variable and 
press ENTER.  
 
Verify  
Validates the syntax of the expression in the expression box if the corresponding table is open. If the 
expression is valid, "Expression is valid" is displayed in the status bar. If it is not valid or if the 
corresponding table is not open, Visual FoxPro displays an error message. This option is not enabled for 
remote views. 

 
Caution  
If you include a user-defined function call in the expression, an error is indicated; however, an error 
does not necessarily occur when the expression is evaluated at run time. 

 
Options  
Displays the Expression Builder Options dialog box, which you can use to set preferences for the 
Expression Builder.  
 
The following table describes some useful functions for manipulating strings in expressions. 
If you want to  Use this function  
Remove leading and trailing blanks from character expressions ALLTRIM( ) Function 
Remove leading blanks LTRIM( ) Function 
Remove trailing blanks RTRIM( ) Function 
Add specified characters to the left, right, or both sides of a 
string 

PADL( ) | PADR( ) | PADC( ) 
Functions 

Work with parts of a character string for comparisons SUBSTR( ) Function 
Use a specified number of characters starting with the left of a 
string 

LEFT( ) Function 

Use a specified number of characters starting from the right of a 
string 

RIGHT( ) Function 

Change uppercase to lowercase, or lowercase to uppercase UPPER( ) Function, LOWER( ) 
Function 

Convert a string to initial capitals PROPER( ) Function 
Have a numeric field interpreted as a character string STR( ) Function 
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Appendix F – Working with Abra version 9 
 
Beginning with Version 9, the Abra installation process has changed and as a result the AbraSuite Data 
has moved to a new location during the upgrade.  This means that you will need to change the Options 
in Abra2BST to reflect the new Abra Data location. 
 
If you are using Windows Server 2003 or Windows XP, your data will now be stored in: 
 

...\Documents and Settings\All Users\Sage\AbraSuite\Data 
 

The export path will be at: 
 

 ...\Documents and Settings\All Users\Sage\AbraSuite\Data\export 
 
 
If you are using Windows Server 2008, Windows Vista or Windows 7, your data will now be stored in:  
 

...\ProgramData\Sage\AbraSuite\Data 
 

The export path will be at: 
 

...\ProgramData\Sage\AbraSuite\Data\export 
 
 
The ProgramData folder is now a Hidden Folder. Because of that, Abra2BST will not be able to see it until 
the Hidden File attribute is removed.   
 
To do this, go to the Organize drop-down menu in Windows Explorer. Under the View Tab check the 
“Show Hidden Files, Folders, and Drives.”   Then right click on the ProgramData folder and go to 
“Properties” to remove the Hidden attribute. 
 
Please note that you will also need to change the export path in BST. 
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